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1 LabTalk Scripting Guide

In this guide we introduce LabTalk, the scripting language in Origin. LabTalk is designed for users who wish to
write and execute scripts to perform analysis and graphing of their data. The purpose of this guide is to help
users who are generally familiar with programming in a scripting language to take advantage of the scripting
capabilities in Origin. We provide sufficient detail for a user with basic knowledge of Origin to begin tailoring the

software to meet their unique needs.

The guide starts with a quick introduction to LabTalk, followed by a chapter on language fundamentals, and a
chapter outlining various ways to organize and execute scripts within the Origin environment. The remaining
chapters are organized by various functional areas of Origin, such as importing, graphing, data analysis, user

interaction, and automation.

A few reference tables are included at the end. However this guide is not a full language reference. The full
LabTalk language reference documentation is accessible from the Help menu in Origin. New features are
continually introduced to LabTalk with successive versions of Origin. These are typically marked with a version

number stamp (i.e., 8.1, typically in a bold and/or red-colored font) in the language reference help file.

This guide should be used in conjunction with other resources for learning LabTalk, which are listed in the
Resources for Learning LabTalk chapter.

' This guide provides several script examples. To try these examples you can either type in the
Q script, or you can simply copy and paste the script from the soft file version of this guide

accessible from the Help menu.

e  Getting Started with LabTalk

e Resources for Learning LabTalk

e LT Language Fundamentals

e LT Calling X-Functions and Origin C Functions

e LT Running and Debugging LabTalk Scripts

e LT String Processing

e LT Workbooks Worksheets and Worksheet Columns

e LT Matrix Books Matrix Sheets and Matrix Objects

e LT Graphing



http://www.originlab.com/doc/LabTalk/guide/Getting-Started-with-LT
http://www.originlab.com/doc/LabTalk/guide/Resources-Learning-LabTalk
http://www.originlab.com/doc/LabTalk/guide/Language-Fundamentals
http://www.originlab.com/doc/LabTalk/guide/Calling-XFs-and-OC-Functions
http://www.originlab.com/doc/LabTalk/guide/Running-and-Debugging-LT-Scripts
http://www.originlab.com/doc/LabTalk/guide/Category-Str-Process
http://www.originlab.com/doc/LabTalk/guide/Workbooks-Worksheets-and-Worksheet-Columns
http://www.originlab.com/doc/LabTalk/guide/Matrix-Books-Matrix-Sheets-and-Matrix-objs
http://www.originlab.com/doc/LabTalk/guide/Graphing
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http://www.originlab.com/doc/LabTalk/guide/Importing
http://www.originlab.com/doc/LabTalk/guide/Exporting
http://www.originlab.com/doc/LabTalk/guide/The-Origin-Project
http://www.originlab.com/doc/LabTalk/guide/Analysis-and-Applications
http://www.originlab.com/doc/LabTalk/guide/User-Interaction
http://www.originlab.com/doc/LabTalk/guide/Working-with-Excel
http://www.originlab.com/doc/LabTalk/guide/LT-Running-R
http://www.originlab.com/doc/LabTalk/guide/work-with-python
http://www.originlab.com/doc/LabTalk/guide/Automation-and-Batch-Processing
http://www.originlab.com/doc/LabTalk/guide/Function-Reference
http://www.originlab.com/doc/LabTalk/guide/Appendix

2 Getting Started with LabTalk

2.1 Hello World

We begin with a classic example to show you how to execute LabTalk script.

1. Open Origin, and from the Window menu, select the Script Window option. The Script Window will
open.

2. In this window, type the following text and then press Enter:

type "Hello World"

Here we used LabTalk command type. Commands can be abbreviated down to 2 characters, try:

ty "Hello World"

Origin will output the text Hello World directly beneath your command.

Note that when you press Enter, Origin adds a semicolon, ;, at the end of the line and also
executes that line of script.

To repeat the execution of a line of script, place the cursor anywhere within the line and press
Enter. If you place the cursor at the end of the line, you need to remove the ; before pressing

Enter to execute that line of script.

Now let us see how to execute multiple lines of script from the script window:

1. With a workbook window active in Origin, open the Script Window
2.  Type the following lines of script in the script window. At the end of each line, press Enter after typing the

;. This will prevent execution of the line. We will later execute all lines together.

type "The current workbook is Sh";
type "This book has $(page.nlayers) sheet(s)";
type "There are $(wks.ncols) columns in the active sheet";

3. Using the mouse, drag and select all lines of script. If using keyboard, place the cursor at the beginning of
the script, then hold down the Shift key, and use the arrow keys to highlight all lines.
4. Press Enter to execute all selected lines of script. Depending on the workbook that was active, the output

in the script window will be similar to the following text:


http://www.originlab.com/doc/LabTalk/guide/Running-Scripts
http://www.originlab.com/doc/LabTalk/guide/Command-stmts
http://www.originlab.com/doc/LabTalk/ref/Type-cmd
http://www.originlab.com/doc/LabTalk/guide/Using-Semicolons-in-LT
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The current workbook is Bookl
This book has 1 sheet(s)
There are 2 columns in the active sheet

In the above example, we used the %H String Register that holds the currently active window name (which could
be a workbook, a matrix, or a graph). We then used the page and wks LabTalk Objects to get the number of
sheets in the book and the number of columns in the sheet. The $() is a substitution notations which tells Origin

to evaluate the expression within the () and return its value.

If you are typing in multiple lines of script in the Script Window, you can add a ; at the end of a
line and then press Enter to avoid execution of the line. This allows you to type in multiple lines

without executing each line. You can then select all lines and press Enter to execute them all.

2.2 Using = to Get Quick Output

The script window can be used as a calculator to return results interactively. Type the following script in the script

window and press Enter:

3+ 5=
Origin computes the result and displays it in the next line:

3 +5 =28
The = character is typically used as an assignment operator, with a left- and right-hand side. When the right-hand

side is missing, the interpreter will evaluate the expression on the left of the = character and print the result in the

script window.

In the following example, we introduce the concept of variables in LabTalk. Entering the following assignment

statement in the script window:

double A = 2
creates a variable A and initializes its value to 2. Then you can perform some arithmetic on variable A, such as

multiplying by PI (a constant defined in Origin, ) and assign the result back to A:

A= APl

To display the current value of A, type:
A=

Press Enter and Origin responds with:

A =6.2831853071796


http://www.originlab.com/doc/LabTalk/guide/String-registers
http://www.originlab.com/doc/LabTalk/ref/Page-obj
http://www.originlab.com/doc/LabTalk/ref/Wks-obj
http://www.originlab.com/doc/LabTalk/guide/LT-objs
http://www.originlab.com/doc/LabTalk/guide/Assignment-stmts
http://www.originlab.com/doc/LabTalk/guide/Assignment-stmts
http://www.originlab.com/doc/LabTalk/guide/Arithmetic-stmt
http://www.originlab.com/doc/LabTalk/guide/Operators
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In addition, there are List command to view a list of variables and their values. Type the following command and

press Enter:

list
Origin will open the LabTalk Variables and Functions dialog that lists all variables.
You can also get a dump of a specific type of variables, for example

list v
to list the numeric variables.

2.3 Other Ways to Execute Script

In previous examples, you saw how to execute script from the Script Window. Origin provides several other

ways to organize and execute LabTalk script. These are outlined in detail in the Running and Debugging

LabTalk Scripts chapter. Here we take a quick look at a few of the methods to execute script: (1) from the

Custom Routine toolbar button, (2) from a custom menu item, and (3) from a button in a graph page.

2.3.1 Custom Routine Button

Origin provides a convenient way to save script and run it with the push of a toolbar button.

1. While holding down Ctrl+Shift on your keyboard, press the Custom Routine button ( ’53'2‘ ) located in the
Standard Toolbar.
2. This opens Code Builder, Origin's native script editor. The file being edited is called Custom.ogs. The

code has one section, [Main], and contains one line of script:

[Main]
type -b S$General.Userbutton;

Replace that line with the following:

[Main]
type -b "Hello World";

Then press the Save ( E ) button in the Code Builder window.

3. Now go back to the Origin application window and click the '58&' button.


http://www.originlab.com/doc/LabTalk/ref/List-cmd
http://www.originlab.com/doc/LabTalk/guide/Data-Types-and-vars
http://www.originlab.com/doc/LabTalk/guide/Running-and-Debugging-LT-Scripts
http://www.originlab.com/doc/LabTalk/guide/Running-and-Debugging-LT-Scripts
http://www.originlab.com/doc/LabTalk/guide/From-a-Toolbar-Button
http://www.originlab.com/doc/LabTalk/guide/From-a-Custom-Menu-Item
http://www.originlab.com/doc/LabTalk/guide/From-Graphical-objs
http://www.originlab.com/doc/Origin-Help/Standard-Toolbar
http://www.originlab.com/doc/LabTalk/guide/Debugging-Tools
http://www.originlab.com/doc/LabTalk/guide/Flow-of-Control
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Origin will again output the text Hello World, but this time, because of the -b switch used with the type command,

the text will be presented in a pop-up window.

2.3.2 Custom Menu Item

LabTalk script can be executed from a custom menu item.

1. Select the menu item Preferences: Custom Menu Organizer... to open the Custom Menu Organizer

dialog.
2. Make the Add Custom Menu tab active. Then right-click inside the left panel and select New Main
Popup from the context menu.
3. Inthe right panel, enter a name for Popup Text, such as My Menu. then click outside of the edit box.
4. Select My Menu from the left panel, and then right click on it, and select Add Item from the context menu.
5. Inthe right panel, change the ltem Text to Hello World, then add the following script to the LabTalk

Script text box:

type -b "Hello World";

7. Click the Close button, and in the window that pops up, press Yes to save the menu changes as Default
menu. In the file dialog that opens, press Save to save the file with the default name to the default folder
(User Files Folder).

8. A new menu named My Menu should now appear in the menu bar, to the left of the Window menu. Click
on this new menu item, and then click on the Hello World entry in the drop-down. A Hello World dialog

will pop up.

2.3.3 Button in a Graph

Origin also provides the ability to add a button to a graph or worksheet, and then execute LabTalk script by

pushing that button. This allows for script to be saved with a specific project or window.

1. Pressthe New Graph button ( ) located in the Standard Toolbar to create a new graph.

2. Pressthe Text Tool button ( T ) in the Tools Toolbar, and then click on the newly created graph and

type the text My Button. Then click outside the text to finish editing the text.


http://www.originlab.com/doc/LabTalk/ref/Type-cmd
http://www.originlab.com/doc/Origin-Help/CustomMenuOrganizer-Dialog
http://www.originlab.com/doc/Origin-Help/UserFilesFolder
http://www.originlab.com/doc/Origin-Help/Standard-Toolbar
http://www.originlab.com/doc/Origin-Help/Tools-Toolbar
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3. Right click on the text to bring up the context menu, and then select Programming Control to open the

Programming Control dialog.

4. Inthe dialog, select Button Up from the Script, Run After: drop-down list, and then type the following

script in the edit box:

type -b "Hello World";

6. Click OK to close the dialog. Now the text label becomes a button. Click the button. A Hello World dialog

will pop up.

2.4 Script Example

We now present a script example that walks you through a particular scenario of importing and processing data,
and then saving the project. This example uses several LabTalk language features such as Commands,

Objects, and X-Functions. You will learn more details about these language features in subsequent chapters.

NOTE: We will use the Script Window to execute these statements. To execute a single line of code, make sure
that you leave out the ; at the end before pressing Enter. For multiple lines of code, at the end of each line, press
Enter after the ; to continue entering the next line. After you have typed in all lines, select them all and then press

Enter to execute.

Let's start with a new project using the doc command and the -n switch. If the current project needs saving, this

command will prompt user to save.

doc -n
Now let's import a data file from the Samples folder. We will first use the dlgfile X-function to locate the desired

file:

dlgfile gr:=ASCII
Then select the file S15-125-03.dat from the \Samples\Import and Export sub folder located in your Origin

installation folder, and click Open.

The above process will load the file path and name into a variable named fname$. You can examine the value of

this variable by typing:

fnames$=

Now let's import this files into the active workbook. We will use the impasc X-Function with options to control

naming, so that the file name does not get assigned to the workbook:
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impasc Options.Names.FNameToBk:=0
Now we want to perform some data processing of the Position column. We first define a range variable to point

to this column.:

range rpos = "Position"

Since the column we select is also the 4th column in the current worksheet, we can also use index number to

specify it.

range rpos = 4
You can check what range variables are currently defined, using this command:

list a

We now normalize the column so that the values go from 0 to 100. To check what X-Functions are available for

normalization, we can use the command:

1x *norm*

The above command will dump X-Functions where the name contains norm. There are several X-Functions for

normalizing data. For our current purpose we will use the rnormalize X-Function.

To get help on the syntax for this particular X-Function, you can type:

rnormalize -h

to dump the information, or type:

help rnormalize

to open the help file.

Let us now normalize the position column:

rnormalize irng:=rpos method:=rangel00 orng:=<input>
The normalized data will be placed in the same column, replacing the original data, as we set the output range

variable orng to be <input>.

When using X-Functions, you can leave out the variable names, if they are specified in the correct order. The

above line of code can therefore be written as:

rnormalize rpos rangelOO0 orng:=<input>
The reason we still specified the name orng is because there are other variables that precede this particular

variable, which are not relevant to our current calculation and were therefore not included in the command.
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Now let's do some changes to the folder in the project. There are several X-Functions for managing project

folders, and we will use some of them:

// Get the name of the current worksheet

string name$ = wks.name$;
// go to root folder
pe cd ..;

// rename Folderl to be the same as worksheet
pe rename Folderl name$;

Now let's list all the sub folders and workbooks under the root folder:

pe dir
Finally, let's save the Origin Project to the User Files Folder. The location of the user files folder is stored in the

string register %Y. You can examine where your User Files Folder is by checking this variable:

o©

Y =
Now let's use the save command to save our project to User Files Folder, with the name MyProject.opj.

save %yMyProject
In the above command %Y will be replaced with the User Files Folder path, and thus our project will be saved in

the correct location.

2.5 Using CTRL + SHIFT to capture Menu Command and Toolbar
Button Script

Many of the actions of menu commands and toolbar buttons in Origin's graphical user interface (GUI) are

implemented in LabTalk script. When this is the case, you can locate and view this script in the following way:

1. Press CTRL + SHIFT on your keyboard and hold.

2. Click on the menu command or toolbar button.
This, then, becomes a source of usable LabTalk Script that you can incorporate into your custom routines.

2.5.1 Example

1. Open a new workbook, select columns A and B, then right-click and choose Fill Columns With: Row

Numbers.

2. With your worksheet active, press CTRL + SHIFT and click the Scatter toolbar button - (or choose

Plot > 2D: Scatter: Scatter).
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This does two things:

e Opens Code Builder (Origin's Integrated Development Environment) to the line in Plot.ogs (an Origin

system script file) to the section that executes the toolbar button or menu command.

e  Writes the menu id and run.section command out to the Script Window.

Menu i1d=33248 (0x81e0)
run.section (Plot, Scatter)

Information from both of these lines of script can be reused in your own scripts, to create a line plot. To see this
at work, make sure that the workbook with your two columns of highlighted row numbers is still active, then go to

the Script Window (Window: Script Window), type either of the following, then press Enter:

menu -e 33248

run.section(Plot, Scatter)
For more information, see these topics:

e FAQ-666 How to open the dialog in Origin by using LabTalk Script?.

e The menu command's "-e" switch.

e Origin's run.section method.

2.6 Where to Go from Here?

The answer to this question is the subject of the rest of the LabTalk Scripting Guide. The examples above only
scratch the surface, but have hopefully provided enough information for you to get a quick start and excited to

learn more. The next chapter lists various resources available for learning LabTalk.
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3 Resources for Learning LabTalk
Besides the content provided in this guide, the following resources are available for learning LabTalk.
3.1 Online Documentation

Most up-to-date documentation for LabTalk, including updates to this guide, can be found online at this location:

http://www.originlab.com/doc/labtalk

3.2 Tutorials

Several LabTalk tutorials are shipped with Origin. These are accessible from the Help menu.

3.3 Script Examples

Various Script Examples are shipped with Origin. These are accessible from the Help menu, and are contained

in the sub folder: <Origin Installation Folder>\Samples\LabTalk Script Examples\.

3.4 X-Function Script Examples

Press the F11 key in Origin to open the XF Script Dialog. This dialog provides many script examples specific to
calling X-Functions, organized in various categories such as Import, Fitting, Signal Processing, and

Spectroscopy.

3.5 LabTalk Forum

Post your question on the LabTalk forum. Go to: http://www.originlab.com/forum and then select the LabTalk

Forum. Our forums are monitored by our technical staff, plus you may get ideas and answers from other power

users as well.
3.6 Training and Consulting

OriginLab and our distributors worldwide offer Training and Consulting services to help you with advanced

customization using LabTalk. Please contact us for further details.
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4 Language Fundamentals

4.1 Language Fundamentals

In this chapter, we introduce various aspects of the LabTalk language structure. In the first section you will learn

about general language features such as data types, variables, operators, conditional and loop structures,
macros and functions. The second section covers features that are unique to LabTalk, such as range and

substitution notation, objects, methods and properties, and accessing X-Functions.

This chapter covers the following topics:

e LT General Lanquage Features

e LT Special Language Features

e |abTalk Script Precedence

4.2 General Language Features

4.2.1 General Language Features

These pages contain information on implementing general features of the LabTalk scripting language. You will

find these types of features in almost every programming language.

This section covers the following topics:

e Data Types and Variables

e Programming Syntax

e  Operators

e Conditional and Loop Structures

L] Macros

e  Functions
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4.2.2 Data Types and Variables

4.2.2.1 LabTalk Data Types
LabTalk supports 9 data types:

Type Comment
Double Double-precision floating-point number
Integer Integers
Constant Numeric data type that value cannot be changed once declared
Dataset Array of numeric values
String Sequences of characters
StringArray Array of strings
Range Refers to a specific region of Origin object (workbook, worksheet, etc.)
Tree Emulates data with a set of branches and leaves
Graphic Object Obijects like labels, arrows, lines, and other user-created graphic elements

4.2.2.1.1Numeric

LabTalk supports three numeric data types: double, int, and const.

1. Double: double-precision floating-point number; this is the default variable type in Origin.

2. Integer: integers (int) are stored as double in LabTalk; truncation is performed during assignment.

3. Constant: constants (const) are a third numeric data type in LabTalk. Once declared, the value of a
constant cannot be changed. From Origin 2016, constant is auto-saved to orgvar.ogs once declared. It
means that the constant will be saved as "System Variable" and available whenever a new Origin

session is conducting.

// Declare a new variable of type double:
double dd = 4.5678;

// Declare a new integer variable:

int vv = 10;

// Declare a new constant:

const em = 0.5772157;

Note:
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e To use a constant after open a new Origin session, you will need to define the constant in the

CONST.CNF file under User File Folder.

e LabTalk does not have a complex datatype. A column can be set as Numeric Complex and basic
operations (+,-,*,/) work between columns or using literal values. While functions are available for
extracting real and imaginary parts of a complex column value or literal expression, you should use Origin

C if you need complex variables.

// Direct, literal expression:

(3-131) / (7+21) =;

// (3-131) / (7+21)=-0.094339622641509-1.83018867924531

// Assign literal expression to complex column

col(A) [3] = (3-131i) * (7+21);

// Get Real part of complex column or literal expression

dReall = imreal (col(A) [3]);

dReal2 = imreal ((3-131) + (7+21));

// Get imaginary part of complex column or literal expression

dImagl = imaginary(col (A) [3]);

dImag?2 = imaginary ((3-131i) - (7+21));
Values such as 0.0, NANUM (missing value) and values between -1.0E-290 to 1.0E-290 will be
evaluated to be False in logic statement. For instance, LabTalk command will return a value 0

(False) instead of 1 (True).

type $(-1e-290?1:0); // Returns 0 (False)
type $(1/021:0); // Returns 0 (False), where 1/0 == NANUM

4.2.2.1.2 Dataset

The Dataset data type is designed to hold an array of numeric values.

4.2.2.1.2.1 Temporary Loose Dataset

When you declare a dataset variable it is stored internally as a local, temporary loose dataset. Temporary
means it will not be saved with the Origin project; loose means it is not affiliated with a particular worksheet.

Temporary loose datasets are used for computation only, and cannot be used for plotting.

The following brief example demonstrates the use of this data type (Dataset type declaration and $() Substitution

Notation are used in this example):

// Declare a dataset 'aa' with values from 1-10,
// with an increment of 0.2:
dataset aa={1:0.2:10};

// Declare integer 'nSize',
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// and assign to it the length of the new array:
int nSize = aa.GetSize();

// Output the number of values in 'aa' to the Script Window:
type "aa has $(nSize) values";

4.2.2.1.2.2 Project Level Loose Dataset

When you create a dataset by vector assignment (without declaration) or by using the Create (Command) it

becomes a project level loose dataset, which can be used for computation or plotting.

Create a project-level loose dataset by assignment,

bb = {10:2:100}
Or by using the Create command:

create % (strWks$) -wdn 10 aa bb;
For more on project-level and local-level variables see the section below on Scope of Variables.

For more on working with Datasets, see Datasets.

For more on working with %( ), see $() Substitution - Numeric to String Conversion.

4.2.2.1.3String

LabTalk supports string handling in two ways: string variables and string registers.

4.2.2.1.3.1 String Variables

String variables may be created by declaration and assignment or by assignment alone (depending on the
desired variable scope), and are denoted in LabTalk by a name comprised of continuous characters (see

Naming Rules below) followed by a $-sign (i.e., stringName$):

// Create a string with local/session scope by declaration and assignment

// Creates a string named "greeting",
// and assigns to it the value "Hello":
string greeting$ = "Hello";

// $ termination is optional in declaration, mandatory for assignment
string FirstName, LastName;

FirstName$ = Isaac;

LastName$ = Newton;

// Create a project string by assignment without declaration:
greeting2$ = "World";//project scope and saved with OPJ

// string variable can make use of string class methods
string str$ = Johann Sebastian Bach;
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str.Find('Sebastian')=;

// Define literal strings

// The syntax <[< indicates the start of literal strings

// The syntax >]> indicates the end of literal strings

// Can be used to include special symbols like double quotation marks in a
string

string sl1$ = <[<a"b'";"c">]>;

sls8=;

//Should return a"b'";"c"

//Use literal strings in X-Function arguments
// Fill in three rows in the current selected worksheet column
patternT text:=<[<"Sample A" "Sample B" "Sample C">]>;

For more information on working with string variables, see the String Processing section.

4.2.2.1.3.2 String Registers

Strings may be stored in String reqisters, denoted by a leading %-sign followed by a letter of the alphabet (i.e.,

%A-%Z). String Registers are always global in scope.

/* Assign to the string register %A the string "Hello World": */
%A = "Hello World";

' For current versions of Origin, we encourage the use of string variables for working with strings,

as they are supported by several useful built-in methods; for more, see String(Object). If,
however, you are already using string registers, see String Registers for complete

documentation on their use.

4.2.2.1.4StringArray

The StringArray data type handles arrays of strings in the same way that the Datasets data type handles arrays
of numbers. Like the String data type, StringArray is supported by several built-in methods; for more, see
StringArray (Object).

The following example demonstrates the use of StringArray:

// Declare string array named "aa"
// and use built-in methods Add, and GetSize:

StringArray aa; // aa is an empty string array

aa.Add ("Boston") ; // aa now has one element: "Boston"
aa.Add ("New York"); // aa has a second element: "New York"
/* Prints "aa has 2 strings in it:" then each string. */

type "aa has $(aa.GetSize()) strings in it:";

loop(ii,1,aa.GetSize())
{
ty aa.GetAt (ii)$;
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4.2.2.1.5Range

The range data type allows functional access to many data-related Origin objects, referring to a specific region in

a workbook, worksheet, graph, layer, or window.

The general syntax is:

range rangeName = [WindowName]LayerNameOrindex!DataRange[subRange]

which can be made specific to data in a workbook, matrix, or graph:

range rangeName = [BookName]SheetNameOrindex!ColumnNameOrindex[RowBegin:RowEnd]

range rangeName =

[MatrixBookName]MatrixSheetNameOrIndex!MatrixObjectNameOrindex[CellBegin:CellEnd]
range rangeName =[GraphName]LayerNameOrindex!DataPlotindex[RowBegin:RowEnNd]
The special syntax